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Happy Potter by Bert Housley ARPS. 
Taken at the West Dean Digital portraiture Workshop. 

2007 MEMBERS PRINT EXHIBITION 
GOLD CUP and CHAIRMAN'S MEDAL 

Serpentine Seat by Stanley Newton ARPS See pages 9 and 10 

DIGITAL IMAGING GROUP 2007 MEMBERS PRINT EXHIBITION 
Opening at The Swindon Library Link from 3 to 28 July 

We plan to show the exhibition also at: 
The Harrow Arts Centre, Hatch End, London NW from 3 to 15 September 

and 
The Old Schoolhouse, Oldbury, West Midlands from 24 September to 7 October 

Also available on the website at www.digit.org.uk/ images/ images.asp 
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From the Chairman 

Once again it was a pleasure to view the range of prints submitted for this year's exhibition 
of members' work. This edition of DIGIT enables us to share the accepted images with 
everyone. 

Our exhibition has a distinct advantage over many others in so far as it gives everyone an 
equal opportunity to show their work, as each member is guaranteed one acceptance. 
The panel of selectors then agrees which picture wi ll go forward to the exhibition. With 
this method of se lection no one style of work or imagination is excluded. It largely 
eliminates the instant gratification factor, where all the right formu laic things have been -.,._. 
so predictably done to catch the judges' eye, that so b lights many an exhibition. It also ensures that if a 
photographer/image-maker wishes to share a way of seeing or work in a particu lar style, then one of their prints 
is certain to be accepted. 

Our selectors this year were Shelagh Roberts FRPS, Mel Gigg FRPS and John Long ARPS and we thank them 
for working hard to ensure broad-based presentation. 

The exhibition will be on tour and venues at present include Swindon, Harrow and Oldbury in the West 
Midlands. If you know of a gallery or exhibition space where you feel the exhibition can be shown, please make 
contact with Alex Dufty our Exhibition Co-ordinator who will be pleased to hear from you. His contact details are 
on the back page of the magazine. 

The DI Group will produce an AV show of all accepted images for the exhibition. I have again been invited to 
make an interpretive and informative commentary about each image. I look forward to this task and I trust 
you ' ll enjoy the result. cltve f-tat:JV\.lS FR.PS 

2006 DI Group Exhibition DVD Still Available 
Last year's exhibition DVD is still available for clubs and home use, with a commentary on each print. It plays 
on your PC or TV through a domestic DVD player. For your copy send a cheque for £6 (£8.50 for delivery out-
side the UK please) payable to RPS DI Group to: Graham Whistler FRPS, 9 Cherrygarth Road, Catisfield, 
Fareham, P015 5NA, UK 

Latest Distinctions for DI Group Members Annual General Meeting 2008 
We are delighted to congratulate the following DI Group We seem to have created some little confusion about 
members who have recently gained distinctions: dates for next year's AGM. It is planned to be held on: 
Fellow: Paula Davies Sunday 20 April 2008 
Associate: Ray Grace; Dr Kenneth Maclennan-Brown AIS; at the slightly earlier time of 1030, with coffee avai lable 

Dr Gwynn Robinson; Andy Thorpe from 1000. Get the date in your diary now and start 
Licentiate: Sharon Boulter; Sara Cody; Peter Irving; planning those three exhibition prints. If you're outside 

Malcolm Onley; David Pollard; David Seaton; the UK remember that Alex Dufty LRPS will make special 
Carol White - Griffiths arrangements to receive your prints unmounted. 

In this issue of your Digital Imaging Group magazine 
2007 DI Group Exhibition - Members' Prints p 11 - 33 
Winning Images: 
• Chairman 's Cup and Gold Medal: Serpentine Seat by Stanley Newton ARPS p 11 
• Ribbons awarded by Mel Gigg FRPS 

- Early Morning Prayer by Andy Beel FRPS and Swimming Pool by Bob Moore HonFRPS p 18 
• Ribbons awarded by John Long ARPS: 

- Lido Torrent by June Cook FRPS and Swallow Tailed Gulls, Galapagos by Mark Whitwell to 
• Ribbons awarded by Shelagh Roberts FRPS: 

- Walking in the Rain by Adrian Herring ARPS and The End of the Pier by Carole Lewis LRPS p 19 

From the Chairman 
What's on Where and News 
AGM 2007 New Committee 

Report 
Print Selection 

p 2 
p 3 
p 3 
p 4 
p 6 
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Get sorted with Rick Alexander LRPS 
Digital portraiture Workshop at West Dean 
Clive Haynes FRPS in soft focus 
Audio Visua l News, Steam Workshop 
Key Contacts 

p 7 
p 9 
p 34 
p 35 
p 36 



Co-ordinator 
Chris Haydon -
right 

AGM Sunday 22 Aprll 2007 
,---------------------, 

RPS Digital imaging Group Committee 
Elected for 2007 / 8 

Chair: Clive Haynes FRPS 
Vice Chair and DIGIT Editor: Jim Buckley LRPS 
Secretary: Bob Pearson ARPS 
Treasurer: David Naylor LRPS 
Webmaster: Bil l Henley LRPS 
Publicity and Website Updates:John Long ARPS 
Exhibitions: Alex Dufty LRPS 
DIGRO Co-ordinator: Chris Haydon 

Maureen Albright ARPS 
Tony Healy ARPS 

Dr Barry Senior FRPS 
Graham Whistler FRPS 

Below - Saying farewell with cheese and wine hampers to 
Peter Roberts ARPS and Glenys Taylor ARPS who retired as 
Treasurer and Secretary after many years of dedicated service. 

What's on Where 
Just a few events that we know about. For full listings see the DI Group website www.digit.org.uk 

DI Group Workshop/Lecture 9 December 2007 DI Group Residential Workshops - see p 9 & 35. 
at The Old School House, Oldbury. Main lecturer Digital Portraiture and Photoshop April 9 - 112008 
Terry Steeley on Photoshop CS3 with Graham West Dean College, Chichester. Limited to just eight 
Whistler FRPS Practical Portrait Session and photographersformaximumtimewith modelsandtutors. 
Wacom demonstration. Should be a great day. Narrow Gauge Railway, Welshpool provisional dates 20-
Note the date and look for details on the website 21 October 2007. See P 35 for an outline of getting 
and in the autumn DIGIT. A number of events up steam with th is practical outdoor workshop. 
around the regions. Contact Chris Haydon, DIGRO Contact Graham Whistler FRPS 01329 84 7944 
Co-Ordinator 01234 782196 or digro@digit.org.uk Email: graham@gwpmultimedia.com 

REGIONAL DI GROUP MEETINGS - SEE BACK COVER FOR CONTACTS 
WESTERN: 34 Thomas Street Taunton Somerset TA2 6HB. 
CENTRAL SOUTHERN: 12 August: Underwater Photography with Len Deeley FRPS and 2006 RPS 
International Slide Exhibition - shown as projected images. 23 September: Not a lot of people know that 
with Roger Maile ARPS - useful but less well-known digital imaging techniques. 28 October: Digital Imaging 
tips and techniques with Gavin Hoey Coopers Hi ll Community Centre, Bracknel l, Berkshire RG12 7QS. 
YORKSHIRE: 5 August 2007: Print Appreciation - Bring your prints. Getting the Best Results using 
PhotoShop with Paul Batty. 25 November 2007: National Media Museum.formerly the National Museum of 
Photography, at Bradford. PhotoShop Live with David Roley.Selby Community Centre, Selby. Y08 4BL 
WESSEX: 9 June: Andy Beel FRPS Digital Black & White Printing at Aldbourne, Wiltshire. 1 July: Digital 
Workshop Bill Henley LRPS and Ray Grace ARPS at Aldbourne. 7 October: Digital AV with Brian Jeffs FRPS. 

New opportunity for dlgltal workers 
RPS International Projected Image Exhibition 2007 

This year there is a new category in what was formerly the Slide Exhibition. Alongside general and nature 
slides there is now an open digital section. Full details at www.rps.org and in the Journal. 
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Annual General Meeting: 22 Aprtl 2007 
Once again the AGM saw a good attendance with over 
70 members making the journey to Smethwick. 

Finances Presenting the accounts for the year to 31 
December 2006, treasurer Peter Roberts explained 
that a good deal had been learned from the almost 
£3,500 deficit arising from D-Day Rugby last year. 
Along with increasing expenditure on DIGIT and an 
exhibition which had been seen more widely, this 
meant that the £13,000 balance of the Group had 
been reduced to £6,400. 

Chairman's Report Clive Haynes FRPS said: I'm 
pleased to report that the group remains in robust 
good health with our membership maintaining at just 
over the 1,000 mark. The excellent condition of the 
group is the result of severa l key features: 

• an informed and lively membership; 
• a committee responsive to the needs of the 
group; 
• a dedicated and hard-working committee 
who not on ly seek to maintain standards but 
to continuously explore new opportunit ies and 
horizons; 
• an excellent journal that reflects the needs 
and interests of our broad membership base; 
• an excellent and attractive website that acts 
as a pivotal point for members, a place of 
contact and discussion, a forum, a folio and 
gallery to share images and ideas. The web 
site also showcases what the group can 
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achieve and acts as a front window for both 
the group and the RPS as a whole 
• a lively programme of regional ly-based 
meetings and events made possible by a 
hard-working and enthusiastic team of Digital 
Regiona l Organisers - DIGROs for short 
• an annual exhibition that reflects members' 
work that is shown in various parts of the UK. 

To be a little more specific: I thank every member of 
the committee for their unstinting dedication and hard 
work. The group can be assured that the members 
of the committee really care about how the group 
is managed, the advantages we offer and the 
direction in which we are heading. Besides the 
regular committee meetings a great deal of work is 
conducted by email and telephone. 

At the AGM three long-serving committee members 
are leaving us: Hilary Roberts, Peter Roberts ARPS and 
Glenys Taylor ARPS. Hilary was co-opted onto the 
committee and for many years she has been a 
sta lwart of the group and principal organiser of the 
decade of Digital Spectacular events. Peter has 
been our lo n g-se rv i ng .-----~-----,r-=-i..-..--............. 

Treasurer and under his 

firm, guiding hand our ..,,-- =-_-:~---~~--;.;: 
accounts have been well l=.!!!f:=¥f!~- -

managed and remain in 
the black. Glenys has 
been a cornerstone of 
the group serving as an 
unflappable secretary 
more years than she 
cares to remember. 

Also at th is AGM we lose ~==============~== 
Carol Hewer ARPS, who 
after a relatively short raises a question 

time on the committee, is not seeking re-election due 
to other commitments. 

I wou ld like to highlight certain areas of committee 
activity. Jim Buckley continues to produce DIGIT - a 
journal that surely must be the envy of other specialist 
groups. The publicat ion goes from strength to 
strength under his editorship. In his role as Vice 
Chairman, I thank Jim for being there when I've 
needed to extend my thinking pattern and to bounce 
certain ideas off him. I can always be assured of a 
considered and rel iable response. 

Bill Henley efficiently continues to oversee the technical 
aspects the group website. The effectiveness of the 
site is a tribute to him and to his son lain who has also 
contributed many hours of hard work. 



Our annual exhibit ion has been skillfully arranged and 
managed once again by Alex Dufty. Alex is one of 
those people who simply get on with the task in hand 
and can be relied upon to produce the results. Thank 
you Alex. 

John Long has continued to ensure that our publicity 
reaches its mark and he maintains the day-to-day 
bulletins and features on our website John is also the 
DIG representative on the RPS Council. 

All in favour? Support for more residential workshops 

Maureen Albright and Graham Whistler have both 
provided invaluable support as and when needed. 
Maureen is always multi-tasking with her deep 
involvement with the AV group and being DIGRO for 
two regions. Graham is able to provide professional
level photographic back-up and advice and our thanks 
go to him for instigating the recent, highly successful 
Digital Portrait Workshop at West Dean - and for 
mastering and copying the DVD of our 2006 
Exhibition. 

Past Chairman Dr. Barry Senior has provided much 
needed support and sage-like advice and for this I 
thank him. 

Although distant, Tony Healy, down-under in Australia, 
keeps in the loop via email and Skype and contributes 
his special knowledge and valuable opinions to our 
electronic discussions. 

During last year we suffered a double blow to our 
group with the deaths of two outstanding members, 
both of whom had been instrumental in the initiation 
of the group and played an integral part in its direction 
and success. I refer of course to Barrie Thomas and 
Eddy Sethna. Many tributes have been paid to these 
two generous and very special people. We miss them 
both deeply, however one thing is assured - that is a 
great deal of what we do, enjoy and develop is not only 
very much due to their foresight but also as a direct 
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result of their willing enthusiasm to openly share their 
skil ls with all of us. 

In November, the Digital Day at Rugby provided a focal 
point for our members. As many of you know, the 
event evoked a mixed response. This has already 
been the subject of discussion and comment via the 
group web-based forum. The committee has plans 
under consideration for this year whereby members 
will be able to meet, share and learn about things 
digital. As the options remain open at this stage, we'll 
be announcing our intention as soon as possible. 

We wi ll be maintaining a closer liaison with 
the DIGROs as a committee post will be made to 
specifically address their needs. Whilst on the subject 
of Regions and DIGROs, the group would like to 
address three geographic areas in particular. First, 
Scotland, where Alistair Knox is unable to continue 
due to health problems. We thank Alistair for his 
sterling work and enthusiasm in running a group 
which covers such a vast area. We therefore seek 
someone to take over the role of organiser in 
Scot land. 

Second, East Anglia is also in need of an organiser as 
Joy Hancock is taking over as Regional Organiser and 
will not be able to combine the two roles. We thank 
Joy for running this group for many years and wish 
her well in her new challenge. We are seeking a 
replacement for Joy in the East Anglia area. 

Third, London: It's a strange thing, but in the most 
densely populated part of the UK with, therefore, 
potential ly the largest number of people for DIG 
membership there must be a need to meet and share 
an interest in digita l imaging. Why, therefore do we 
have a gap in our regional structure? We continue to 
appeal for someone to help in the London area - we 
look forward to hearing from you, whoever you are. 

In closing, I would like to thank everyone for their 
continuing support and enthusiasm for this, the 
largest - and we trust, the most successful special 
interest group within the RPS. 

With the formal approval of the Report and Accounts 
the meeting moved on to the recent digital workshop 
at West Dean College. Graham Whistler FRPS reported 
on the successful 21; 2 day residential portraiture event 
- see page 9 for more - and sought members' views on 
further and different workshops. Although not every
one could afford the cost, there was general support 
for a varied programme of residential events. 

As the meeting closed, Rosemary Wilman ARPS, Chair 
of the Exhibitions Committee on the Council thanked 
the Chairman on behalf of the Society. 



Members' Exhibition Print Selectlon and Mel Glgg FRPS lecture 

With the AGM over the selection of prints for the exhi
bition was under way. This year's distinguished 
judges, seen here, were Mel Gigg FRPS, Shelagh 
Roberts FRPS and John Long ARPS. And they did not 
have an easy job in choosing from the enormously 
varied range of photographs submitted. They 

encompassed apparently straight images to some 
wholly constructed it seemed, with both mono and 
colour being used. Some were themed panels, of 
sport for example, others abstract, even minimalist, 
delicate patterns. And as usual we had a couple of 
dedicated members who submitted from Australia and 
South Africa. Special arrangements are made to 
mount the prints from overseas once received in the 
UK. 

Assisted by Ron Morgan LRPS and committee 
members, Alex Dufty ran a smooth operation to 
ensure that all 375 entries were properly displayed 
and assessed before the lunch break. 

Some experienced mem
bers who had not been able 
to sit near the front had 
sensibly equipped them
selves with binoculars to 
perform their own scrutiny. 

After an excellent lunch from the 
staff of the Old School House, 
home of the Smethwick Photo 
Soc, it was time to announce the 
results. 

I Let's have a closer look at this one I 

Ron Morgan LRPS 
complete with white 
gloves displays the 

prints 
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Overall winner was Stanley 
Newton ARPS with his 
Serpentine Seat. He was 
awarded the Gold medal 
and the Chairman's Cup. 

Each judge then had the 
a pair of Ribbon winners 

as their personal choice. Shelagh's Ribbons went to 
Walking in the Rain by Adrian Herring 
ARPS and The End of the Pier by 
Carole Lewis LRPS. 
Mel Gigg's choices were Early 
Morning Prayer by Andy Beel FRPS 
and Swimming Pool by Bob Moore 
Hon FR PS. John Long settled on Udo 
Torrent by June 
Cook FR PS and .---1'-m_s_u-re_it_~_i_ll be- a-ln_'gh_t o_n_th_e _m_igh_t--,! 

Swallow Tailed An apprehensive Alex Dufty LRPS, 
Gulls, Galapagos Exhibition Co-ordinator, before the 
by Mark Whitwell. selection 

Garate Lewis LRPS 
receives her Ribbon 

frrm 

Stea{J!RcretsFRP-:, 

Mel Gigg FRPS 
presents Andy Beel 

FRPS with his Ribbon 

To round off the day, hard working Mel Gigg FRPS 
treated members to an exploration of techniques 
involved in infra red photography using a digital cam
era which would accept conventional IR filters like the 
R72. He showed how to post process these images in 
Photoshop. And, yes, I am hoping to persuade him to 
write an article for 
DIGIT on this subject 

Mel Gigg FRPS 
demonstrates some 

techniques to unravel the 
mysteries of di@tal infra 

red photography 



Get Sorted I And stay sorted I 
Rick Alexander LRPS says that this article is the result of his New Year Resolution. 
Faced with the decision to catalogue and sort his images in some sort of order he 
found much by trial and error the system which he outlines below. Although he has 
worked with Adobe Photoshop for many years he admits to knowing only a small part 
of its range of tools to help the photographer but this method may be just what you 
need to trigger action on that all important task of cataloguing your pictures. You may 
find it helpful to work through Rick's procedure with Bridge open. 

When faced with a drawer full of CDs and DVDs and 
still more images on the main drive of my computer I 
was forced to find a system of cataloguing them. The 
system is based around Adobe Bridge's Keywords. I 
had often looked at them and wondered what they 
were for but this time I clicked on help and asked for 
the information on keywords. Thus started the 
process of learning about another of Adobe's tools 
designed to help us with creating images. 

I am now able open Bridge and use File>Find to gain 
immediate access to those images I want to work on 
or to find inspiration in, seeing stored images again in 
new light. The system works best when storing the 
images on a hard disk, ideally removable but with suf
ficient capacity to store lots of images. I use a 250 
Giga byte hard disk in a removable cradle wh ich con
nects to the IDEE cable of my main PC. A USB exter
nal hard disk would be nearly as quick but I found 
using DVDs directly for searches much slower. 

Setup As a first stage make a new, main folder cal led 
Images and as many subfolders as you need to 
accommodate the years of digital images, like this: 

Images____.. 2004 
2005 
2006 
2007 

Now open Bridge - and this works in CS3 Bridge Beta 
as well - and go to View and check that Keywords is 
ticked. This window is usually found with the 
Metadata window and should look something like this: 

----- -, ... -

The Keywords window is set up with some default va l
ues to illustrate the way the Keywords operate. Bridge 
allows the Keywords to be kept in Keywords Sets. You 
can see an example of Keyword Sets in the red circle 
in the screen grab in the previous column. on the left. 
Over a period of some months I developed the follow
ing list of Keywords for my own needs: 

Botanical 
Creative 
Events 

Holidays 
People 
Places 
Wi ldlife 

Other Keywords 

How and what Keywords 
Sets are used are very 

I 0:' :lfJO ~ li.eyw0rCl5 

As>igntd K•ywo,d,1 

much a reflection of the --------~ 
.., Botanical 

photographer's work and cacti 

creative interests. Time =.. 
spent analysing this aspect rrises 

Leaves 
will be repaid handsomely MaQnolas 

later on, although usage of ::S 
Keywords will cause the list 
to be modified over time. 

Trees 
.., Creative 

Abstroct 
Bluo 
LJlt,ting 
Monochrcme 
Orange 
Pattern 
Red 

. -

-

The Keyword Window has 
three icons along its bot
tom edge as you can see. 

Whte ~ 

Icon 1 allows the creation 
of a new Keyword Set; 4/ 

1 2 3 

• u __ _ 

·-·-· -·-~- :·•••••1 111• 
Icon 2 al lows the 
creation of a new 
Keyword; 

·- ---------...... -~.,.,._-~""- - .,-_...__.A,llla....__ -,. - .... -... -"'· - ... - ... - ... -.... - ... . -...... 

r• -----· .,_.,.. .,_, _ ,__ _____________________ __, 
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Icon 3 deletes the highlighted Set or Word. 

Selecting a Set and clicking on the New Word 
icon will create a new Keyword which will 
require a name. Searches cannot be made on 
Keyword Sets only on a Keyword. 

Keyword Sets or Keyword Names can be 
renamed at any time by right clicking on the 
highlighted item. Also remember that search-



ing can be on all or any part of the Keyword so it is 
best to use single Keywords. Keywords should be 
unique as the Find command allows multip le 
keywords to be searched. 

cataloguing It is good practice when downloading 
images from your camera to have a set process to 
ensure that images are not lost and have keywords 
written to them. As a first stage I recommended that 
the images are downloaded to a temporary folder from 
your camera. 

Start Bridge and load the images which should then 
be assessed, deleted as appropriate, and assigned a 
Keyword. It is important to have at least one Keyword 
assigned to every image. If the images are to be 
copied to a hard disk it is best practice to make a copy 
at this stage to a CD or DVD or an external hard drive. 
Afterwards, with two copies, it is safe to delete the 
images from the camera. The final stage is to copy the 
images to the year sub-folder in the Images folder. 

Finding a picture With all your photos tagged with one 
or more Keywords you are ready to search on the 
Keywords. In Bridge go to Edit>Find. 

Scuce 

~'"' ~, im.,ges----------~..:.l &owse ... I 
,:; JnaJde Al Si.bflli:lers 

r Fnd Alfles 

ilzi ,·M .:J lconUhs 

r 

Match: lu :,r,y CM$1.l "'" met 

r Showl'ndresutsnarov,aowse,wro:,w 

+ 

..:.l 

X 

The window above is set up the find images with the 
Keyword Orchids in the folder Images and its subfolders. 
The results will be shown in the present Bridge 
Window but you can choose to open them in a new 
browser window. 

Look in gives access to the chosen folder by using the 
Browse button. The f irst field in Criteria offers eleven 
choices to search on. Here I have chosen the 
Keyword. The second field gives access to five 
settings of which contains is the most useful. The 
third field allows you to enter Text Enter the prime 
Keyword to search on here. 

Clicking on the + button will create another row of 
criteria to refine the search stil l further. Clicking on 
the - button wil l delete a row of criteria. Match will 
al low two logical alternatives for the search: Either If 
any criteria are met or If all criteria are met 

Having set the criteria click the Find button and the 
images will appear in Bridge. Magic! 

YOUR DIGIT NEEDS YOU! 
Yes, I need your help. This is issue 35 
of the magazine - not bad for a new 
kid on the block which first appeared 
just a short decade ago. And this is 
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my tenth DIGIT. I rely on some bril- "---------==i 

liant regular contributors who never 
let me down - they know who they are, and I am eter
nally grateful. I also seek out those from the Group 
who have produced successful distinction panels 
so that we can all learn from their experience. So, 
yes, I need lots of images and words from you but I 
also need a few people who will take on some of the 
tasks of gathering information and images. I'm just 
running out of time to do it all myself and I want to 
avoid apologies like that below. 

Specifically I would love to have several members 
to: 

• Keep a sharp eye on the Folio and web 
competition to spot great images and contact the 
photographer to persuade them to send a high res
olution file and a few hundred words on how they 
did it; 

• Contact DI Group members who have gained 
distinctions to cajole them to write about their expe
riences; 
• Develop tutorials from their own favourite pic

tures, remembering that not everyone is famil iar 

with the more sophisticated techniques so these 

should be straightforward and easy to follow. 

Will YOU answer the cal l? I look forward to hearing 

from you at editor@digit.org uk 5ditor 

Spring 2007 DIGIT 
Apologies to John Miles LRPS and others. Some 
last minute editing at the printers went wrong and 
led to problems in issue 34. In particular, the last 
paragraph of John's article on page 9 should have 
read: 
As I said earlier, I like a bit of drama in my land
scapes and architecture and HOR imaging allows 
me to accentuate/enhance this in many cases 
such as in this Clifton Suspension Bridge scene 
above. 

On the other hand HOR can help me create a love
ly landscape faster and with more control than the 
tradition mix of grad NOs and Photoshop layer
ing/masking. HOR is now a major component of my 
kitbag and darkroom and I'm looking forward to 
seeing it develop both in camera technology and 
software goodies. HORI is a lot of fun. I urge you to 
experiment. 



Digital Imaging Group Workshop 
Portraiture at West Dean, Sussex 

Graham Whistler FRPS has run a number of small workshops for 
members over the past few years. With access to the facilities of a 
college and conference centre where he lectures from time to time, 
Graham once again generously offered his time and expertise on an 
intensive residential course at Easter. Working alongside Graham 
was Clive Haynes FRPS who ran master classes in the computer 
suite so that each member could have individual coaching to get 
the best out of their images using Photoshop. I was able to see it 

----------'--=-----"-';;...._--' all in action when I joined the workshop on their first full day. 

As I turned the car in through the gates an idyll ic 
landscaped park opened up before me. New-born 
lambs catapulted themselves vertica lly into the air as 
the drive led me towards a grand building. Gill Haynes' 
photograph above captures the day beautifully. 
Eight delegates were just sipping their last coffees at 
the end of breakfast. Graham had spent the previous 
evening briefing them on camera settings, calibration 

_,r-a:rw.a.--r.---.-----.-. of monitors and the 
theory of lighting for 
portraiture using a digita l 
camera and studio flash. 
Now it was into one of 
West Dean's grand rooms 
to get to grips with it in 
practice. And a very busy 
studio session it proved to 
be. Denis was a super 

character model on the first day and Camilla an 
attractive young lady on the fol lowing day. Clive was 
kept very busy in the computer room on both days but 
did have some t ime to take a few portraits of his own 
and was able to use these for his demonstration of 
use of complex Photoshop CS2 adjustment layers to 
produce the final images. A number of portraits have 
been posted on the DI Group Folio; and on page 34 
Clive expla ins the soft focus technique which he used. 

Graham told me: Our eight RPS 'students ' - Anita 
Boddy ARPS, Heather Coulson ARPS, Raymond Fi/sell, 
Howard Fisher LRPS, Dr Christopher Ley and Ian 
Lindsley LRPS were joined by two new members Linda 
Wellington and Rosemary Crahart. By chance Bert 
Housley ARPS came to my West Dean course the 
week before so we could see his results too. All said 
they had a very 
good time and ,--G-ra_h_a_m_c_o_a_c-he_s_L_i-nd_a_ w_h-ils_t_la_n_, 

learned plenty. directs the reflector on Denis 
They all produced ,__ __________ ____, 

some very high 
quality work and 
thought West Dean 
was a super place 
for the event. They 
hoped this was the 
first of many more 
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similar events and West Dean would be happy to have 
a DI Group workshop again next year so we have 
taken the plunge and booked it. See page 3 for brief 
details. 

West Dean is able to offer good conditions for 
disabled photographers and so we welcome those 
who have limited mobility. Please contact West Dean 
who will be very happy to give you details of their 
facilities at www.westdean.org.uk. Telephone the 
Head of HR and Customer Care on 01243 818256 to 
discuss individual circumstances. 

Each member of the workshop had their own PC with 
Photoshop CS2 whilst Clive's PC was linked to a projector 

so everyone could see his demonstrations. 



I'd like to say thank you for a wonderful workshop which I thoroughly enjoyed. / learned 
a Jot · I even remembered quite a bit of the Photoshop work! I've posted a few of the pies 
on http://www.mrsite.co.uk,lusersitesv/llndagrenfell.com/ wwwroot;page13.htm I will 

certainly be joining the Group and I look forward to other workshop opportunities. 

UIMAR 
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,. 

course led by Graham Whistler and Clive Haynes. The 

enthusiasm and easy manner of imparting knowledge 

was greatly appreciated by the attendees. We all left 

having learned a great deal and are most grateful to 

our tutors. If the DI Group repeats such courses I can 

strongly recommend and urge members to attend · 

you will not regret it and will return home enthused, 

having learned a great deal. 1-towcwcl 



Serpentine Seat 

RPS Digital Imaging Group 
2007 Members' Exhibition 

Gold Medal and Chalnnan's Cup 
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Stanley Newton ARPS 



Twilight Ti me Chris Kislingbury ARPS 

Winter Trudge Jeffrey Bartlett ARPS 

Autumn Brilliance Peter Read LRPS 
Washday, Surano John Long ARPS 

Bicycle Buckets and Brolly Elizabeth Restall LRPS Summer's Bloom Paula Davies FRPS 
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Crispino 

Abandoned 

Modern Gypsy 

Rain at Hodge Close 

Norman Wiles LRPS 

Mike Feldman FRPS 

Ray Wallace Thompson ARPS New York Deli 

13 

Peter Chance LRPS 

Moth Orchid John Berry ARPS 

Bernard Crix LRPS 



Bottles Cesi Jennings LRPS 

Just Nuts 

Emerging from Mist 

The Enchanted Wood Veronica Barraclough ARPS 

Barry Senior FRPS 
Curvature #1 Howard Fisher LRPS 

l 
Anne Mahany Bank Holiday Monday 
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Sylvia Kislingbury ARPS 



Caribbean Invitation Eric Smith 

Hall of The Fairy Queen Rick Alexander LRPS 

Sand Patterns John Nathan LRPS 

The Chair 

Reflections on Autumn 

Spring Cyclist 
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_.., 
~ ... . ·---

Irene Froy FRPS 

George Hodlin ARPS 

Bill Wisden Hon FRPS 



Daffs John Lacey ARPS Old Car in Woods 

Seed Heads of Canadian Poppy 
Howard Hilton ARPS 

Computer Power Jeff Lawrence 

Paris Metro 2 ' 

Sossusvlei 
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Brian Seaney FRPS 

Bill Henley LRPS 

Celia Paren ARPS 



Fitful Light Ron Pain LRPS 

Edge of a Wood Peter Rawson ARPS 

Autumn Jane Lightfoot LRPS 

Evening Light - Monument Valley 
Roger Norton LRPS 

Abandoned Bob Pearson ARPS 
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2007 Dlgltal Imaging Group 

Swallow-tailed Gulls Galapagos Mark Whitwell 

The End of the Pier Carole Lewis LRPS 

Early morning prayer Andy Beel FRPS 
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Exhibition - Ribbon Winners 

Just Walking in the Rain Adrian Herring ARPS 
Swimming Pool Bob Moore Hon FRPS 

Lido Torrent June Cook FRPS 
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Male Speckled Wood Butterfly Walter Easter LRPS 

- - - -----~ 

The French Cabinet Maker Doreen Haines LRPS 

Elements of Nepal David Eaves ARPS 

Lloyd's Fantasy 

Frustrated Shopper 

Autumn Reflections 
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Mike Howell ARPS 

Jim Marsden FRPS 

Sheila Read FRPS 



Musical Triptych 

Museum Light (2) Guy Davies LRPS 

The Abys 

Blue Mosque at prayers Leonard Viner-Caudrey 

Seals (Southern Ireland) Mel Stallworthy LRPS 
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Anne Gilmore LRPS 

Bert Crawshaw ARPS 

Australian Spring Peter Gawthrop LRPS 



Cardinal Beetle John Scotten ARPS 

Gloucester Cathedral Cloisters 
Norman Chappell LRPS 

Monique Vanstone 

Swimming Lessons 01 Ray Reeves 

Ambush! John Mahany 

Winter Afternoon Bosham Jim Buckley LRPS 
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Portland from Kimmeridge Roger Holmam ARPS 

Pink John Sparks LRPS 

Broken Jetty Brian Cooke LRPS 

Manpower John Buries FRPS 

... 

Secrets Bryn Richards LRPS Alice in Wonderland Glen lrven LRPS 
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Crommack Water Barry Willcock LRPS 

Millie Carol Smart 

Scratching Sara Bunn ARPS 

On the Straight and Narrow Alison Cawley LRPS 

Becalmed Adrian Smithson LRPS 

Alone 
Rosemary Wilman ARPS 
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Reflections 

Siblings Margaret Salisbury FRPS 

Broadside 

Prayers on the Beach 

No Exit 
Malcolm Kitto ARPS 

Richard Donovan Clevedon Pier 
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Editha Robinson LRPS 

Joanne Searle ARPS 

Alan Lewis LRPS 



Reflections of the Wharf James Foad A Stranger Calls Ian Ledgard LRPS 

Don't mess with me Fiona Senior FRPS Homing Beacon Gwynn Robinson ARPS 

The Tasman Sea David Britton 

Mont Pourri Jerry Wiggin ARPS 
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Red Arrows 3 
Charles Minchell ARPS 

Path of gold Michael Amison LRPS 

Ghost Dancer Shirley Britton ARPS 

Apprehensive 
George lley ARPS 

Bleak Midwinter 

Yellowstone Falls 
Tony Healy ARPS 
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Alan Dedman LRPS 



Analogie Clive Haynes FRPS 

Alstromeria 
Shelagh Roberts FRPS 

Rannoch Moor Robert Croft LRPS 

Pavement Shadows 
Dennis Stephenson ARPS 

Rape Field Valerie Rawlins FRPS 

Green Mantle Ron Holmes ARPS 
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BathTime Graham Whistler FRPS 
Mount Andromeda Bert Housley ARPS 

Clematis Yellow Glenys Taylor ARPS 

The Studio Door Jeanne Bradban LRPS 

To the cottage garden Cheryl Miller ARPS 

The end of the line David Cooke 
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Illusion Jean Pain LRPS All Aboard Ron Morgan LRPS 

,,, 

Parrot Tulips Norma Phillips LRPS 

Gladioli Impression Ray Grace ARPS 

Rick Chris Haydon 
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Marrakesh Market, Dusk Maureen Albright ARPS 



Snowdonia from Anglesey John Lewis LRPS Portholes Clifford Marsh LRPS 

Castle View Ralph Bennett ARPS Station Services Moira Taylor LRPS 

North Sea Rainbow 
Walking on the Harbour Alex Dufty LRPS 

Nick Ayers ARPS 
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Frosty Morning, Tangle Creek Eileen Bennett ARPS 

Crane Robert Mair LRPS 

- -

Callanish Clifford Brown LRPS 

.. 

Morning Calm - Windermere Baron Woods FRPS 

Gone fishing Jean Ashton ARPS All lined up with nowhere to go Gerry Wellls 
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Towards the flag!! Martin Elder ARPS 

Rusty Nail Carol Wiles ARPS 

Short Back & Sides Sue Moore FRPS 

OK, I believe you Ron Gafney LRPS 

Early Spring Robert Albright FRPS 
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Soft-Focus Effect 
At the digital portraiture workshop at West Dean Clive Haynes FRPS demonstrated 
this glamour style. The soft focus technique has its origins in traditional photography 
and darkroom methods. Diffusion lenses on camera, a fine mesh (stocking 
material was sometimes used) placed over the enlarger lens or changing focus 
position during exposure were all methods used to make skin tones more 
glamourous and flattering. The idea is to create gentle skin texture on a portrait 
whilst maintaining detail and sharpness where required. Here Clive leads us 
through the effect using Gamilla who modelled at West Dean. The original image is 
shown on the right. In this example Clive chose to isolate a section of the image by 
making a tight crop to ensure concentration on Gamilla's eyes and mouth. 

Getting Started Open the image and make a 
duplicate. Place the duplicate on the layer above. 
Name this layer Blur 1 . 

-

Working on the Blur 1 
layer, go to: 
Fi iter>BI ur>Ga ussia n 
Blur. Set the amount 
to between 4 and 12 
pxls. The amount you 
use wi ll depend upon 
image f ile size. Set 
Layer Opacity to 80% 
Blend Mode: Change 
from Normal to Lighten 

Next Make another 
duplicate of the image 
and arrange it to be 
below Blur 1. Name 
th is new layer Blur 2. 
Working on the Blur 2 

......_ _ _ ___, goto: 

Filter>Blur>Gaussian Blur. Set the amount to around 
50% of that used for Blur 1. 

Set Layer Opacity to 40% 
Blend Mode: Change from Normal to Darken. 

Selective Sharpening and Finishing Touches To carry 
out this phase we 

Depending on your version of Photoshop (or other 
software) you need to fol low the Layer Group (CS/ CS2) 
informat ion or the Layer Set (pre CS versions) 
information below. 

PS CS2: Creating the Layer Group Highlight (to 
activate) both Blur Layers. Click and drag these two 
Layers to the Group icon (it looks like a folder and is to 
the right of the Layer Mask icon) at the base of the 
Layers palette. A Layer Group will appear. 

The two Blur Layers are inside this Group. To view and 
work further upon the individual Blur Layers, click on 
the large arrow on the Group to the left of the folder. 

You can name the Group if you wish, just like a normal 
Layer: name it Blur perhaps. 

Pre PSCS: Creating a Layer Set 
Link the two Blur by using the Link icon: click in the lit
tle grey square next to t he eye icon for the non-active 
Blur layer - a chain-link icon will appear and the two 
Blur layers are now linked . 

Go to the fly-out layer menu (top RH of layer pa lette) 
and choose New Set from Linked. A Layer Set will 
appear at t he top of t he layer stack. The two Blur lay
ers are inside this Layer Set. To view and work further 
on these layers, click on the large arrow on the Layer 

Set to the left of the 
fo lder. You can 

need to treat the two 
Blur Layers as a 
single unit, yet keep 

Soft-Focus Effect Typical Layer Order name the Layer Set if 
you wish, just like a 
normal Layer: name i.,y.., 

our options open for Lighten .., Opdy,[- > 

possible fu rther Lock,D .Y +a Fo1,i 100% ~ 

work on either of the • ,.. '--' • D Gr""" 1 

two Blur Layers. 
Merging t he two • ~ Blur I 

Blu r Layers wou ld " IIJ 
remove this possibility 111ur

2 

9 " B"*grr,und so wish ing to li'..1 
retain maximum '"'* 0 - i:!1 ~- _J :J.J ;r 

Layer 'Group' with Layer Mask. 
Black and grey areas show 
where 'selective erasure' 
has been applied 

flexibi lity we're going 
to create a Layer 
Group. 

Note: In earlier versions of Photoshop 'Group' 
was referred to as a 'Layer Set' 
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it Blur perhaps . 

Creating a Layer 
Mask A Layer Mask 
is the preferred 
method to restore all 
or part of the original 
picture by selectively 
erasing areas of t he 
two Blur Layers by 
working on the Layer 
Group/Set. 



Ensure that the Layer Group is active (highl ighted) 
then click on the Layer Mask icon at the base of the 
Layers palette. A Layer Mask will appear on the Layer 
Group itself. Using black as the Foreground colour 
and a suitable brush, sections of the Blur Layer Set 
can be selectively erased to reveal the Background 
image below. To restore the effect, swap to white as 
the foreground colour and use the brush again. In th is 
way the image can be made as a combination of 
diffused areas and the original picture. 

Sharpening may be applied to the image but remember 
to apply this only to the original image beneath the 
Blur Layer Group. 

Should selective erasing of one of the Blur Layers 
themselves be needed, then create a Layer Mask on 
the required Blur Layer within the Layer Group. 

I find the eyes, lips and areas of the hair when 
revealed by the Layer Mask create that essent ial 
sparkle and focal points that are important for the 
picture. 

Photoshop Know-How, Techniques & Tips can be 
found on my website: www.crhfoto.co.uk 
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Audio Vlsual News 
With so much cross over between digital and AV 
work here's your update on this exciting special 
interest group's activities. And DI members enjoy 
the East Midlands discount tool 

15th National Audio Visual Championships 
Friday 21 to Sunday 23 September 2007 at The 
Civic Centre, Kingsway, Braunstone, Leicester 
LE3 2PP. 5 minutes from Junction 21 M1/ M69 
Costs: Various packages are available from judging 
sessions only, through to all meals, beverages and 
judging sessions. Accommodation to be booked 
independently. 
Jury: The digital sequences submitted will be 
assessed by Malcolm Imhoff FRPS (Chairman), 
Eddie Spence FRPS and Edgar Gibbs FRPS. Details 
from: www.navc.org.uk or Brian Jeffs on 0116 
2778452 Email: brian-ieffs@tiscali.co.uk 

RPS Audio Visual Group - East Midlands 
Sunday 28 October 2007 1000 to 1700 at 
Narborough Parish Centre, Narborough, Leicester, 
LE19 2EL 3 miles south of J21 M1/M69. 
Lecturers: Eddie Spence FRPS, Valerie Rawlins 
FRPS, plus Attenders' Sequences. Cost: RPS AV 
Group/DI Group £8.50; all others £10.50. Optional 
lunch £5.25 
Contact: Beth Elston on 01530 224206 or Email: 
beth.elston@btinternet.com 

2008 Royal Photographic Society 
International Review rl Images with Sound Under 25s 
This new RPS International Digita l AV Competition 
scheduled for early 2008 will be web based and 
specifically for young people under 25. Cash prizes 
for the students and a prize for the institution 
should encourage colleges and schools all over the 
world who have a photography department to 
take part. Please spread the word. For rules and 
information see: www.iris-25.rps.org 

Weekend Workshop 
Welshpool & Uanfair Light Railway 
Private photo charter for RPS DI 
Group. Steam train from Welshpool 

.,.._ --~ 

·'"' . ,.,...__ 
, I ' \_ 

, . 
- ~-=...::,'~ 

at dawn for misty landscape shots. Climb on board 
with stops at several photographic locations. Photo 
run-pasts, station and workshops. Very scenic 
railway, ro lling hills, mostly farms and light 
woodland. Long climb out is steep and very dramatic. 
Hotel in Welshpool. Laptops available to download 
members' pictures and print a few. Powys Castle is 
nearby. Up to 20 places, accompanied by partners 
if desired. See page 3 for possible dates and 
contact details. 
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KEY CONTACTS 
RPS DIGITAL IMAGING GROUP 

Cha ir: Clive Haynes FRPS 
01905 356405 

chairman@digit.org. uk 

Vice-Chair and Editor DIGIT 
Jim Buckley LRPS 
01932 843893 

editor@digit.org.uk 

Secretary: Bob Pearson ARPS 
01404 841171 

secretarv@digit.org. uk 

Treasurer: David Naylor LRPS 
01780 784607 

treasurer@digit.org. uk 

Webmaster: Bill Henley LRPS 
01453 825068 
weh@digit.org.uk 

Publicity and Website Updates: 
John Long ARPS 
01179 672231 

webauerv@digit.org, uk 

Dr Barry Senior FRPS 
01425 471489 

barrv@littfepics.freeserve.co. uk 

Exhibitions: Alex Dufty LRPS 
01454 778485 

exhibition@diqit. orq. uk 

DIGR0 Co-ordinator: Chris Haydon 
01234 782196 

digro@d;g;t, org, uk 

Tony Healy ARPS 
+61 (0) 2 9958 1570 

tonvhealv@optusnet.com.au 

Graham Wh istler FRPS 
01329 847944 

graham@gwpmuftimedia.com 

Maureen Albright ARPS 
01672 540754 

maureen@maureenafbright, com 

DIGITAL REGIONAL ORGANISERS 
Members wishing to attend regional digital imaging meetings should contact 

the organisers listed below for full details 

Central Southern 
Moira Taylor LRPS 

nol,greenside@onetel.com 

Cumbria 
Harry Bosworth 

harrvbos@aot.com 

East Midlands 
Bob Rowe ARPS 

www.rpsdigital-em.org.uk 
bob.rowelO@ntlwodd com 

Eiger (East Anglia) 
Vacant 

Midlands 
Clive Haynes FRPS 

www.midigorg 
cfive@crhfoto.co.uk 

Scotland 
Vacant 

Southern 
Dr Barry Senior FRPS 

barrv@littteoics. freesrve. co. uk 

South Wales 
Maureen Albright ARPS 

www.southwales-dig.rps.org 
maureen@maureenalbrig_ht com 

Wessex 
Maureen Albright ARPS 
www.digNeSSeX.ri:s,org 

maureen@maureenatbrig_htcom 

Western 
Glenys Taylor ARPS 

gtenvs.tavtor©tiscali co.uk 

Yorkshire 

Robert Croft LRPS 
http:/ jyorkshire-digJ.rT¥i/te.orange.co.uly' 

robert@robertcroft.wanadoo.co,uk 

And finally, when will you send us an article for DIGIT? Remember that everyone is learning and that all experi
ence is valuable. We look forward t o hearing from you. Emai l to editor@digit .org.uk. Thank you. 

JLVIA.. "fsuc~Le!j LR.PS 6o!Ltor 
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